BEHAVIORAL INFLUENCE MODELING AND SIMULATION

Scott Klein
Ball Aerospace & Technologies Corporation
Systems Engineering Solutions
Fairborn, OH 45324

JUNE 2014

FINAL REPORT

Distribution A: Approved for public release; distribution unlimited

AIR FORCE RESEARCH LABORATORY
711th HUMAN PERFORMANCE WING
HUMAN EFFECTIVENESS DIRECTORATE
AIR FORCE MATERIEL COMMAND
WRIGHT-PATTERSON AIR FORCE BASE, OH 45433
UNITED STATES AIR FORCE

STINFO Copy
Notice and Signature Page

Using Government drawings, specifications, or other data included in this document for any purpose other than Government procurement does not in any way obligate the U.S. Government. The fact that the Government formulated or supplied the drawings, specifications, or other data does not license the holder or any other person or corporation; or convey any rights or permission to manufacture, use, or sell any patented invention that may relate to them.

This report was cleared for public release by the 88th Air Base Wing Public Affairs Office and is available to the general public, including foreign nationals. Copies may be obtained from the Defense Technical Information Center (DTIC) (http://www.dtic.mil)

AFRL-RH-WP-TR-2014-0098 HAS BEEN REVIEWED AND IS APPROVED FOR PUBLICATION IN ACCORDANCE WITH ASSIGNED DISTRIBUTION STATEMENT.

//signature//
_______________________________________             ______________________________________
MICHAEL YOUNG, Ph.D.                   LOUISE CARTER, Ph.D.
Work Unit Manager                         Chief, Human-Centered ISR Division
Human Trust and Interaction Branch         Human Effectiveness Directorate
                                          711th Human Performance Wing
                                          Air Force Research Laboratory

This report is published in the interest of scientific and technical information exchange and its publication does not constitute the Government’s approval or disapproval of its ideas or findings.
**REPORT DOCUMENTATION PAGE**

<table>
<thead>
<tr>
<th>1. REPORT DATE (DD-MM-YY)</th>
<th>2. REPORT TYPE</th>
<th>3. DATES COVERED (From – To)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 June 2014</td>
<td>Final</td>
<td>22 Apr 2009 – 30 June 2014</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. TITLE AND SUBTITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Behavioral Influence Modeling and Simulation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5a. CONTRACT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>FA8650-08-D-6801/0020</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5b. GRANT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5c. PROGRAM ELEMENT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>5d. PROJECT NUMBER</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5e. TASK NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>TO-20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5f. WORK UNIT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>H16Z (7184X23W)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6. AUTHOR(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scott Klein</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ball Aerospace &amp; Technologies Corporation</td>
</tr>
<tr>
<td>Systems Engineering Solutions</td>
</tr>
<tr>
<td>2875 Presidential Drive, Suite 180</td>
</tr>
<tr>
<td>Fairborn, OH 45324</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8. PERFORMING ORGANIZATION REPORT NUMBER</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>9. SPONSORING / MONITORING AGENCY NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air Force Materiel Command</td>
</tr>
<tr>
<td>Air Force Research Laboratory</td>
</tr>
<tr>
<td>711th Human Performance Wing</td>
</tr>
<tr>
<td>Human Effectiveness Directorate</td>
</tr>
<tr>
<td>Human-Centered ISR Division</td>
</tr>
<tr>
<td>Human Trust and Interaction Branch</td>
</tr>
<tr>
<td>Wright-Patterson AFB OH 45433</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>10. SPONSORING/MONITORING AGENCY ACRONYM(S)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>11. SPONSORING/MONITORING AGENCY REPORT NUMBER(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFRL-RH-WP-TR-2014-0098</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>12. DISTRIBUTION/AVAILABILITY STATEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution A. Approved for public release; distribution unlimited</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13. SUPPLEMENTARY NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>88ABW-2014-4352; Cleared 16 September 2014</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>14. ABSTRACT (Maximum 200 words)</th>
</tr>
</thead>
<tbody>
<tr>
<td>This final report summarizes research and development support that Ball Aerospace provided to the 711th Human Performance Wing, Human Effectiveness Directorate (RH), through the Warfighter Interface Research and Technology Operations (WIRTO) Contract (FA8650-08-D-6801), Task Order 0020, “Behavioral Influence Modeling and Simulation.” This task order supported research within the Human-Centered ISR Division (RHX) that focused on cognitive models that incorporated various types of tacit knowledge, such as cultural ethics and behavior. Models of tacit knowledge need to be visualized in a format that provides analysis, comparison, manipulation, and recognition of that knowledge. Research into data collection tools and translation services was executed. Results are provided. All task objectives were met and all required deliverables were submitted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15. SUBJECT TERMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Model Architecture (OMAR), human social cultural behavioral modeling and simulation, cognitive models, tacit knowledge</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16. SECURITY CLASSIFICATION OF:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. REPORT</td>
</tr>
<tr>
<td>U</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>17. LIMITATION OF ABSTRACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>18. NUMBER OF PAGES</th>
</tr>
</thead>
<tbody>
<tr>
<td>64</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19a. NAME OF RESPONSIBLE PERSON (Monitor)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr. Michael Young</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19b. TELEPHONE NUMBER (Include Area Code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Form 298 (Rev. 8-98) Prescribed by ANSI Std. Z39-18</td>
</tr>
</tbody>
</table>
THIS PAGE LEFT BLANK INTENTIONALLY.
TABLE OF CONTENTS

LIST OF FIGURES ........................................................................................................................ v
1.0 SUMMARY ................................................................................................................................. 1
2.0 INTRODUCTION ......................................................................................................................... 2
3.0 METHODS, ASSUMPTIONS AND PROCEDURES ................................................................. 3
  3.1 Scenario Generation and Display .......................................................................................... 3
    3.1.1 OMAR ............................................................................................................................. 3
    3.1.2 Neverwinter Nights ........................................................................................................ 3
  3.2 Analysis Application ............................................................................................................. 3
    3.2.1 PDAT ............................................................................................................................... 3
    3.2.2 Scenario Tools ............................................................................................................... 3
  3.3 Researching Categorization and Stereotyping .................................................................... 3
4.0 RESULTS AND DISCUSSION ................................................................................................. 5
  4.1 PDAT Data Generator .......................................................................................................... 5
    4.1.1 Main Screen .................................................................................................................. 5
    4.1.2 Backcloth File .............................................................................................................. 5
  4.2 PDAT ................................................................................................................................... 5
    4.2.1 Main Screen Display ..................................................................................................... 5
    4.2.2 Menu ............................................................................................................................. 6
    4.2.3 Tool Bar ....................................................................................................................... 7
    4.2.4 Graph ............................................................................................................................ 7
    4.2.5 Data ............................................................................................................................... 8
    4.2.6 Status Bar ..................................................................................................................... 8
    4.2.7 Scenario Tools ............................................................................................................. 8
    4.2.8 Graph Manipulation ..................................................................................................... 13
  4.3 Graph Structure .................................................................................................................... 13
    4.3.1 Conceptual Graph Structure ......................................................................................... 14
    4.3.2 Scenario Based Graph Structure ................................................................................. 15
  4.4 Data Collection Selection ..................................................................................................... 18
    4.4.1 Data Collection ............................................................................................................. 18
    4.4.2 Criteria for English data collection tool ...................................................................... 18
    4.4.3 Phase One Collection Tool ......................................................................................... 19
    4.4.4 Phase Two Data Collection Tool ................................................................................ 21
  4.5 Survey Results ....................................................................................................................... 22
    4.5.1 Qualtrics Survey Results ............................................................................................. 23
    4.5.2 Tablet Survey Results ................................................................................................... 23
  4.6 Survey Interpreter .................................................................................................................. 24
    4.6.1 Menu ............................................................................................................................ 24
LIST OF FIGURES

Figure 1. Neverwinter Nights ................................................................. 4
Figure 2. Neverwinter Nights’ Office ...................................................... 4
Figure 3. Neverwinter Nights’ Conversation ............................................ 4
Figure 4. PDAT Application ................................................................. 6
Figure 5. Menu .................................................................................. 7
Figure 6. Tool Bar ............................................................................. 7
Figure 7. Polyhedral Graph vs. 2D Graph ............................................. 7
Figure 8. Run Scenario ..................................................................... 9
Figure 9. Manual Exercise ................................................................. 10
Figure 10. Session Comparison ......................................................... 11
Figure 11. Single Session Comparison ............................................... 12
Figure 12. Dual Session Comparison .................................................. 13
Figure 13. Dual Side-By-Side ............................................................ 14
Figure 14. Conceptual Graph ............................................................. 15
Figure 15. Scenario Based Graph ....................................................... 16
Figure 16. Interest Trigger ................................................................. 17
Figure 17. Decision .......................................................................... 17
Figure 18. Category Question Display .............................................. 20
Figure 19. Demographic Question Display ......................................... 21
Figure 20. Tablet Category Question Display ...................................... 22
Figure 21. Tablet Demographic Question Display ................................ 23
Figure 22. Survey Interpreter Main Screen ......................................... 24
Figure 23. Survey Interpreter Menu ................................................... 24
Figure 24. Loaded Results in Survey Interpreter ................................. 25
Figure 25. Interpret Screen in Survey Interpreter ................................. 26
Figure 26. Survey Analysis Main Screen ........................................... 27
Figure 27. Survey Analysis Menu ...................................................... 27
Figure 28. Survey Analysis Load Screen ........................................... 28
Figure 29. Survey Analysis with Results ........................................... 29
Figure 30. Question Table ............................................................... 30
Figure 31. Question Information ....................................................... 31
Figure 32. Summary Report ............................................................ 32
Figure 33. Connectivity ................................................................. 34
Figure 34. Aggregates ................................................................. 35
Figure 35. Aggregate Report .......................................................... 36
Figure 36. Tentatives ................................................................. 36
Figure 37. Answer Table ............................................................... 37
Figure 38. Answers ....................................................................................................................... 38
Figure 39. Subjects........................................................................................................................ 39
Figure 40. Subject Summary......................................................................................................... 40
Figure 41. Panel Report ................................................................................................................ 41
Figure 42. Subject Aggregates .................................................................................................... 41
Figure 43. Demographic Information Groups .......................................................................... 42
Figure 44. Data Annotation ........................................................................................................ 42
Figure 45. Modify Question Types ............................................................................................. 43
Figure 46. Nationalities ............................................................................................................... 44
Figure 47. Time in US .................................................................................................................. 45
Figure 48. Languages .................................................................................................................. 46
Figure 49. Survey Summary ....................................................................................................... 46
Figure 50. Survey Summary Selection ....................................................................................... 47
Figure 51. Summary Survey (American) .................................................................................... 48
Figure 52. Translation Option Table ........................................................................................... 50
Figure 53. Newspaper Answer ................................................................................................. 51
1.0 SUMMARY

This final report summarizes research and development support that Ball Aerospace provided to the 711th Human Performance Wing, Human Effectiveness Directorate (RH), through the Warfighter Interface Research and Technology Operations (WIRTO) Contract (FA8650-08-D-6801), Task Order 0020 (TO 20), “Behavioral Influence Modeling and Simulation.” Under TO 20, Ball Aerospace supported research within the Human-Centered Intelligence, Surveillance and Reconnaissance (ISR) Division (RHX) that was focused on cognitive models that incorporated various types of tacit knowledge, such as cultural ethics and behavior. In the context of the overall WIRTO research, this task focused on supporting research in cognitive modeling and dynamic visualization of understanding. Models of tacit knowledge need to be visualized in a format that provides analysis, comparison, manipulation, and recognition of that knowledge. Research into data collection tools and translation services was executed. Results are provided.
2.0 INTRODUCTION

Under WIRTO TO 20, Ball Aerospace supported research on cognitive models that incorporated various types of tacit knowledge such as cultural ethics and behavior. The cognitive models were created with the Operator Model Architecture (OMAR) software for the Air Force Research Laboratory (AFRL). The cognitive models animated avatars in the simulation environment Neverwinter Nights (NWN). A software visualization tool called the Polyhedral Dynamics Analysis Tool (PDAT), also developed by Ball for AFRL earlier under this task order, was modified to enable the tacit knowledge in the cognitive models to be displayed. PDAT enables models of tacit knowledge to be visualized in a format that provides analysis, comparison, manipulation, and recognition of the tacit knowledge. Under this task order, the PDAT was modified to incorporate scenario data and analysis. Scenario data is generated from scenario runs using OMAR and NWN. PDAT will provide tools to analyze knowledge models and recognize knowledge patterns. Research into data collection tools and translation services was executed.

TO 20 consisted of three subtasks: one technical subtask, a program management subtask, and final report delivery. This final report documents the activities and accomplishments of those subtasks and the subcontractor, and fulfills Contract Data Requirements List (CDRL) Data Item A001.
3.0 METHODS, ASSUMPTIONS AND PROCEDURES

3.1 Scenario Generation and Display

Scenarios are run using OMAR to send commands to NWN, which displays the scenario in a virtual environment.

3.1.1. OMAR

OMAR is a software suite that supports the development of simulation and agent-based systems. It is the software architecture in which the cognitive models and scenarios have been developed for this project. The two main functions are to send and receive data on the scenario to NWN, and to output the results of the scenario into a scenario (.scn) file for use in the PDAT application.

3.1.2. Neverwinter Nights

Neverwinter Nights is a software application that provides a virtual environment for our scenarios. Virtual environments have been generated in the application to simulate our generated scenarios. Agents are controlled via command from the OMAR application, and results of the actions are returned to OMAR for recording. Figures 1, 2, and 3 are examples of the office virtual environment that was generated.

3.2 Analysis Application

Analysis of the scenario is performed by the PDAT application.

3.2.1. PDAT

PDAT was updated to handle scenario data that came from the OMAR/Neverwinter Nights’ scenarios. PDAT was originally developed to graph and analyze cognitive models using a number of analysis tools and reports that could determine strong links between elements and help discover patterns of stereotypes.

3.2.2. Scenario Tools

In order to fully use the data provided in the scenario files, a number of scenario tools were added for use in PDAT. These tools include Run Scenario, Manual Scenario, Single Session Comparison, Dual Session Comparison, and Dual Side By Side Comparison.

3.3 Researching Categorization and Stereotyping

Research was conducted to expand the scenarios with better knowledge models.
Figure 1: Neverwinter Nights

Figure 2: Neverwinter Nights’ Office

Figure 3: Neverwinter Nights’ Conversation
4.0 RESULTS AND DISCUSSION

4.1 PDAT Data Generator
The PDAT Data Generator takes the scenario files generated from OMAR and parses out the applicable data for use in generating a backcloth (.bclth) file for use in PDAT. The backcloth lists nodes that are elements of the scenario and places them on the graph according to the type and time of the event. The Generator can also create backcloth files without loading a scenario file, but the output is less sophisticated and more time intensive.

4.1.1. Main Screen
The main screen has three major sections: the scenario panel, the nodes panel, and the concepts panel. The scenario panel is used to load the scenario file. The concepts (agents) can be selected on load. Once loaded, the nodes and concepts are filled in. The lists can be modified in each respective panel. Once the data is correct, the user saves the data into a backcloth file.

4.1.2. Backcloth File
The backcloth file is generated by the PDAT Data Generator, and loaded by PDAT. The file is xml based, and it contains the nodes and concepts that will be graphed. Along with the nodes and concepts is the scenario data. The scenario data lists nodes and concepts, along with the time at which they are activated. The order of the nodes also determines the path that is graphed. The node and concept list contains all the possible activation nodes and concepts, but each scenario within the file may use a smaller percentage of them.

4.2 PDAT
4.2.1. Main Screen Display
The main screen is made up of five elements: Menu, Tool Bar, Graph, Data, and Status Bar (see Figure 4). This design has the main elements displayed (graph, concept, and node lists) with other features one to two clicks away.
4.2.2. Menu

The menu consists of seven menu items: File, View, Reports, Scenario, Options, Layout, and Help (see Figure 5). The File menu contains the file load/save actions for the application. The View menu has viewing selections for the application. The Reports menu lists reports for the applications, broken up into four sections: Graph Data, Node, Edge and Concepts. All scenario tools are found under the Scenario menu. Application options are located in the Options menu. The different layouts in which the graph can be generated are listed in the Layout menu. The Help menu contains the various help features.
4.2.3. Tool Bar

The tool bar has quick launch icons for the application (see Figure 6). It also contains some graph manipulation tools, such as zoom and node sizing. The quick launch icons contain some of the menu items. The last element on the tool bar is the Concepts combo box.

4.2.4. Graph

The majority of the application display is the graph itself. The graph can be built in two different ways, Polyhedral and two dimensional (2D) (see Figure 7). The polyhedral is a three dimensional (3D) display of the graph, whereas the 2D is a two dimensional display of the graph. 2D displays typically generate faster than polyhedral displays.
4.2.5. Data

The right side of the application contains the graph data. It is split into two lists: concepts and concept nodes. The concept list contains all concepts that are used to build the graph. The concept node list populates with data when a concept is selected. The lists provide some functionality, mainly centering selected nodes and highlighting selected concepts. Concepts can also be modified through this display.

The right side of the application can display reports/tools, depending on whether reports are generated as pop-ups or tabs on the right side.

4.2.6. Status Bar

The status bar is located at the bottom of the application. It displays information and warnings about the application. Information is displayed for a given amount of time and the status bar displays information such as node data and load status. Errors are displayed in red, without a timer, and inform the user of a failure in the application, such as a file that did not load correctly.

The status bar also displays progress for those functions which are time consuming, such as drawing a large graph, or loading data.

4.2.7. Scenario Tools

The Scenario menu contains six different tools for the application. These tools are similar to those used for reports; they can be displayed as a tab or in their own window. The scenario tools provide two key functions: displaying graph activation from the provided scenario and analysis of the scenario.

**Run Scenario:** Run Scenario is an application that takes Scenario files (.scn) that were generated by OMAR and allows the user to run the scenario against the backcloth loaded into the PDAT graph. Run Scenario has a number of settings for manipulation of how the scenario is run and viewed. These settings include: following scenario time, or specifying the amount of time between each event (see Figure 8). Nodes are activated in the graph according to the specifications of the scenario. The amount of time the node is activated can be modified.

Run Scenario can also be modified to take images for future analysis. Images can be predefined in the settings, such as after an activation event or in a constant interval. Image events can be added on the main screen for a specific time or event number.

The application is broken up into six parts: Session, Scenario, Show Node, Event, Activation and Button Panel. Session contains the session information, name, time, nodes activated and concepts activated. Scenario loads the scenario file. Show Node sets the node for display in the activation panel. Event is broken into three tabs: All, Recent and Imaging. All lists all events in the scenario. Recent lists the last event, the current event, and the next two events, with the current event displayed larger for easy viewing. Imaging lists and modifies imaging events. The activation panel displays a line graph for interest nodes and attribute and disposition values for decision nodes. The button panel contains the settings and scenario run controls.
The application will run through the scenario, displaying each event as it is processed. It also updates the graph and activation panel. Images are taken and stored in the file system for later analysis.

Figure 8: Run Scenario

**Manual Exercise:** Manual Exercise is a simple exercise tool that uses data that is completely user generated. The user creates a list of attributes to activate and sets the level of activation. Once the list of activations are created and applied, the matching concepts are listed in order of closest match. This tool can be used in defining stereotypes based on the loaded backcloth (see Figure 9).
**Figure 9: Manual Exercise**

**Session Comparison:** Session Comparison takes the session data saved from Run Scenario and compares it to a second set of session data. The display is broken up into three sections: a session panel, a common panel and another session panel. Each session has its own display, with the panel containing common data in between the two. The session panel displays a graph with lists of unique activated nodes and concepts. The graph and lists are pulled from the time or event selected in the common section. If an activated node is activated in both sessions, the information is placed in the common area (see Figure 10).
**Single Session Run:** Single Session Run is very similar to Run Scenario, in that it takes a scenario file and activates the graph based on events from the scenario file. It differs in that it saves no session or image information and has no activation panel. The main difference is that it does not run through the scenario in a step by step, time based manner. The user selects a range of time or events (i.e., from 1 minute to 3 minutes, or event 6 through event 12), and all nodes/concepts that are active in this range will be activated immediately (see Figure 11).
**Figure 11: Single Session Comparison**

**Dual Session Comparison:** Dual Session Comparison is similar to Single Session Run, but uses two scenarios instead of one. Like Single Session Comparison, the scenarios are loaded, the ranges are selected and the graph is updated to display the activations. Both scenarios are displayed in the same graph for comparison. The activations are in different colors, and if they both activate the same element, a third color is used to represent this. The ranges can be set to match, or each scenario can represent a different range (see Figure 12).
Figure 12: Dual Session Comparison

**Dual Side-By-Side:** Dual Side-By-Side is very much the same as Dual Session Comparison, except that each scenario displays its own graph (see Figure 13).

### 4.2.8. Graph Manipulation

The graph display can be manipulated for better use. Each element of the graph (concepts, edges, and nodes) can be filtered out. The graph nodes can be moved around, and the graph itself can be rotated to bring other nodes to the front. Nodes can be centered on the screen, and node size can be adjusted with a slider on the tool bar. The graph nodes can be the concept nodes, or be reduced to represent the concepts themselves, linking to other concepts that share a similar concept node.

### 4.3 Graph Structure

PDAT can display two structure types for analysis: Conceptual and Scenario Based.
4.3.1. Conceptual Graph Structure

The conceptual graph structure is generated from matrix (.matrix) files, or subset Node (.nodes) and Concept (.concepts) files. The graph is structured to have a number of nodes that represent features or attributes, as well as concepts that create the edges between the nodes. Nodes have no predefined locations on the graph, but depending on the strength of the edges between nodes, the nodes may be bunched together on the graph.

In the simple example displayed in Figure 14, there are two concepts: polar bear and brown bear. The polar bear has white hair color (X4), very large body size (X13), long hair (X3), no tail (X14), and found in the zoo (X19). The brown bear has brown hair (X9), very large body size (X13), long hair (X3) and no tail (X14). Attributes that are exclusively polar bear are grouped together, and shared attributes are also grouped together.

Some assumptions might be made looking at this simple graph. The edges between X3, X13 and X14 may be stronger based on the fact that two concepts group those three together. When presented with a concept that is very large and has long hair, the graph may automatically assume the concept has no tail.
4.3.2. Scenario-Based Graph Structure

The scenario-based graph structure is built from a scenario (.scn) file. The scenario-based graph is different from the conceptual graph in multiple ways. First, there are multiple types of nodes on the graph. Second, the location on the graph is somewhat defined by the type of node, and the time in the scenario when the node was generated. Third, all edges in the graph are created equally (see Figure 15).

Node Types: There are five types of nodes in the scenario-based graph: Interest, Trigger, External Event, Decision, and Disposition.

Interest: Interest nodes are spherical nodes, located on the left side of the graph (see Figure 16). These nodes represent an interest of a subject that will rise and fall based on the scenario. Interest nodes have thresholds, that when met, will fire off the trigger.
Figure 15: Scenario-Based Graph

Trigger: Trigger nodes are cylindrical and are located on the left side of the graph, just to the right of the interest nodes. When an interest crosses a threshold, the trigger node is activated. In Figure 16, the subject reaches the threshold for calling her niece. This is the point at which the interest is so high, it triggers an external action. The trigger links to the external event that occurs because of that interest.
External Event: External events are cubes by default (see Figure 17), except in the special case of a decision event. External events provide flow for the scenario. They are lined up sequentially from top to bottom, with the earliest events at the top. External events take up the middle sections of the graph. Within the middle section events that may be triggered are on the left side, events that may affect disposition are on the right side, and everything else falls in between. Typical external events include leaving and arriving at a location, conversation (saying and hearing), and picking up the phone.

Decision: Decision nodes are special external nodes. Decision nodes are conical and are located in the middle of the graph. A decision node on the graph represents a decision point, in which there are multiple choices for action. The decision is influenced by the subject’s disposition. The decision node is linked to multiple other external nodes, but only one external node will be selected. In Figure 17, the subject is going to call her niece about her concern for her daughter. There are two choices: calling about her daughter’s Muslim acquaintance, or her Sunni acquaintance.

Disposition: Disposition nodes are spherical nodes on the right side of the graph. Disposition nodes are attributes used by decision nodes to evaluate a situation and make a choice. In Figure 17, there are three dispositions: the subject’s religion, the subject’s daughter’s potential husband’s religion, and the subject’s daughter’s religion. They all influence the decision. If every religion is the same, the conversation may be more pleasant. If the potential husband’s religion does not match their religion, the conversation may be more problematic.
4.4 Data Collection Selection

Data collection is split into two phases. In Phase one, data was collected in English, using Qualtrics survey software that was adapted to our needs. In Phase two, data will be collected in the respondent’s native language, and English. Data will be collected using an Android application that was developed and installed onto a Samsung tablet.

4.4.1. Data Collection

In addition to creating visualization methods, techniques were developed to collect data to populate future knowledge models. Data were gathered from subjects who self-identified as one of three nationalities; American, Chinese or Indian. The data were broken into two subsets. The first subset was data that were retrieved from these subjects when they read and answered experiment questions in English. The second subset of data came from additional subjects as they answered a subset of the original questions in their native language and English. It was discovered that a majority of the subjects (including the Chinese and Indian subjects) type in English, when using a computer. Therefore, in order to get results in which the subjects were not thinking in English, a second subset of data would be collected by having the subjects hand write their answers on a tablet computer. Hence, two different data collection tools would be necessary.

4.4.2. Criteria for English data collection tool

A variety of criteria was used to select the software used for data collection. They included:

a. Response count
b. Data format
c. Languages supported
d. Software documentation
e. Extensible
f. Clean display
g. Software support
h. Cost

The data collection software was evaluated against these criteria. Any tool that didn’t meet the first three criteria was thrown out, as it would be unable to accomplish the tasks required. Once a tool met these main requirements, it was tested on how well it met the other requirements and how difficult it would be to overcome any deficiencies.

Data Collection Options: A total of 24 data collection tools were evaluated for potential use. Seven were selected as candidates for final analysis, and 17 options were discarded for failing to meet a required specification. The 17 discarded tools were Digivey, Fluid Surveys, Inquisite, Survey Systems, Survey Pro 5, Global Park, Cvent, Blue/Surveys, Checkbox Survey Online, Checkbox Survey Server, Cogix ViewsFlash, Feedback Server On-Demand, Feedback Server On-Site, KeySurvey, phpESP, StatPac, and Survey Said. The seven selected tools are detailed in the following sections.

Lime Surveys: Lime Surveys is a free on-line survey package with unlimited surveys and responses. It has adequate data output formats and can prevent someone from taking the survey
multiple times. The tool is basic, but it may not cover all the languages needed for this research. The question types are limited.

See URL: http://www.limesurvey.org

**Qualtrics:** Qualtrics is an on-line survey that provides a large number of features including an extensive question type selection, language support, and an on-line library of tips and support. Even with purchase, there is a limited number of responses allowed, and only one user may edit the surveys.

See URL: http://www.qualtrics.com/survey-software/

**Snap Surveys:** Snap Surveys provides two options, a survey hosted on-line or a downloadable survey to host on your own server. It covers the languages needed and has acceptable output formats. The cost is high in comparison to the quality of the surveys, and the software does not provide any time controls.

See URL: http://www.snapsurveys.com/us/

**Survey Gizmo:** Survey Gizmo provides usable data output formats along with unlimited surveys and language support. Timing controls are lacking, and it does not provide translations.

See URL: http://www.surveygizmo.com/

**Survey Monkey Pro:** Survey Monkey Pro is an application that was recommended by co-workers who currently use it. It provides 1000 responses at a low monthly cost. It is also easy to use. It provides great service for the basic features, but is not extensible enough to provide the controls needed for the research.

See URL: http://www.surveymonkey.com

**Toluna:** Toluna is a company which has a basic survey tool with few features. Toluna may be a great resource in panel procurement, if needed in the future. The lack of features makes this tool unacceptable for our use.

See URL: http://www.toluna-group.com

**Zoomerang:** Zoomerang provides unlimited surveys and responses. It can display images, but not video. It can be used in a kiosk version and provides adequate data output formats. It cannot control time. It also does not support all the languages we need, and only allows for one user.

See URL: http://www.zoomerang.com/online-surveys/

### 4.4.3. Phase One Collection Tool

Qualtrics was selected as the data collection tool for Phase I. The requirements for the experiment required a number of complex features that eliminated most of the other tools. These requirements included the need to record data entry and exit times, auto-flipping to the next question after a predefined amount of time, and disabling forward and backward buttons.
**Category Survey Data Collection**: The survey is composed of 15 demographic questions and 60 category questions. The survey will take around 75 minutes.

**Category Questions**: Category questions are timed, and entry times are recorded. Users have 60 seconds to answer each question, and there is enough space for up to 20 categories under each question (see Figure 18). Between each category question is a black screen that lasts for 5 seconds.

![Figure 18: Category Question Display](image-url)
**Demographic Questions:** Demographic questions are untimed, and the user can answer them at their own pace (see Figure 19).

![Survey form with demographic questions](image)

**Figure 19:** Demographic Question Display

4.4.4. **Phase Two Data Collection Tool**

A Samsung Galaxy tablet was selected for Phase II data collection. A category survey application was developed and installed onto the tablet in three different languages. The languages were English, Chinese and Hindi.

**Category Survey Data Collection:** The Category Survey is composed of 15 demographic questions and 20 category questions. The survey takes approximately 40 minutes to complete.

**Category Questions:** Category questions are timed, and entry times are recorded. Users are given 60 seconds to complete each question, with space for up to 20 categories under each question (see Figure 20). Between each category question, a black screen is presented that lasts for 5 seconds.
4.5 Survey Results

Each survey generates results that are accumulated and distributed. The format of these results is different for the two survey collections tools.

Figure 20: Tablet Category Question Display

Demographic Questions: Demographic questions are untimed, and the user can answer them at their own pace (see Figure 21).
4.5.1. Qualtrics Survey Results

Qualtrics allows for a number of different formats for downloading its results. The format that was selected for this research was comma separated values (CSV). Due to the CSV format, Microsoft Excel was used to browse through the results. In addition, this format enables data to be easily loaded into other applications for deeper analysis.

In addition to listing every question used in the survey, the results file lists every other field that is displayed or not used in the survey. The automatically generated data, such as the subject Identification (ID) and survey start and end times are located at the beginning of the results file.

The majority of the file consists of the answers given for each question (up to 20 per question) as well as the entry and exit times of those answers. From these three pieces of information, a larger data object can be stitched together. This data object, called the Survey Answer, contains the actual answer, the time the answer was started, the time the answer was ended, the amount of time it took to create the answer, and the order in which the answer was given. Since these pieces are scattered in the results file or are calculated, a Survey Analysis tool was developed for consolidating the data.

4.5.2. Tablet Survey Results

The tablet survey obtains inputs from the subjects through an interface that lets the users write each letter instead of typing it (except for the demographic information which is still typed using the tablet’s digital keyboard). These written results can be in multiple languages.
Each subject has a folder that stores their survey results. Within that folder are two types of data files: a properties file and image files. The properties file contains the entry/exit times, demographic and other hard data. The image files are snapshots of every letter entered by the subjects. The filename indicates the question # / answer # / letter # it represents.

Before the results can be sent to the Survey Analysis tool, the letter files need to be interpreted by a language analyst. The results from the tablet surveys are sent through the Survey Interpreter tool.

4.6 Survey Interpreter

The Survey Interpreter tool is used for converting subjects’ written results into a format that can be used in the Survey Analysis tool (see Figure 22).

![Survey Interpreter Main Screen](image)

**Figure 22: Survey Interpreter Main Screen**

4.6.1. Menu

The menu (Figure 23) has three menu items: File, View, and Help. The File menu contains the file load/save actions for the application. The View menu has viewing selections for the application. The Help menu contains the various help features.

![Survey Interpreter Menu](image)

**Figure 23: Survey Interpreter Menu**
4.6.2. Main Screen

The main screen of Survey Interpreter contains a table of all the subjects and number of solved and unsolved answers (see Figure 24). The analyst can select a specific subject by clicking their row in the table. Otherwise pressing the “Select All Unsolved” button will select all subjects. Clicking the “Start” button will bring up the interpret panels.

![Survey Interpreter](image)

**Figure 24: Loaded Results in Survey Interpreter**

4.6.3. Interpret Panel

The Interpret Panel displays answers for survey questions (see Figure 25). The answers are the images taken from the tablet that are placed in order for the analyst. The survey question can be selected at the top of the screen, and the unsolved answers are listed. If the analyst can interpret the answers, they type them into the text field. If there is no answer, they can check the box “No Answer”, which indicates that the analyst has reviewed that answer and found that no answer was provided. When satisfied with their interpretations, the analyst may click “Save and Return” to return to the main screen, or “Save and Next” to move to the next question with unsolved answers.
4.7 Survey Analysis

Once all the data is collected, it is still in a raw format and not very useful. In order to make the data more useful, it must be condensed into groups of data that can be used for display in sortable tables and reports. Survey Analysis allows the analyst to take the raw data, combine similar elements of data and generate reports (see Figure 26).
4.7.1. Menu

There are five menu items in Survey Analysis (see Figure 27). File contains the file load and save features, View has the tool tips option, Analyst Data lists all the tools for data arranging and manipulation, Reports lists general reports that can be generated, and Helps lists the help features for the application.

4.7.2. Loading and Viewing Survey Results

In order to use the application, the results from the survey must be loaded.

**Loading Survey Results:** The results from Qualtrics that were saved can be loaded into the application. To load the data, click on the Open menu item in the File menu (see Figure 28).
Figure 28: Survey Analysis Load Screen

**Loaded Survey Results**: The survey results are loaded into the application and the screen displays a summary of the results on the left side of the screen. The summary includes the number of questions, answers and subjects (see Figure 29).
Questions: All of the questions in the survey are loaded into the application. The data and reporting are broken up by all questions and by single questions. The Question Table lists every question in the survey, and the Question Information page displays data and reports for a single question.

Question Table: The Question Table is accessible by clicking the “Questions” link on the left side of the screen (see Figure 30). The table lists the survey questions by Question Number, text, category and program generated report type. Type is used to order the questions in the table in a way that shows the most important question at the top of the table.
Question Information: The Question Information screen can be found by selecting a question ID in the Question Table (see Figure 31). The screen is broken up into four sections: Question Information Survey Results Summary, Reports, Edit, and Answer table.

Question Information Summary: The summary panel at the top of the screen displays the question number, the sub question number, code (if applicable), category and text of the question.

Reports: The reports panel lists two reports for generation: Summary and Connectivity.
Summary Report: The summary report takes all the answers to the question and calculates a number of pieces of information that summarizes the results (see Figure 32). The top left corner lists the overall statistics of the question. Answers count is the number of total answers for the question. Unique answers is the count of different answers provided (aggregated answers count as one). Average per subject shows how many answers were provided for the question per subject on average. The average answer time is the average time it took for each one of the answers in this question.

The bottom section of the report lists all the unique answers for the question, and the individual statistics for each answer. Along with the number and average time, as in the summary statistics, it also lists average location, first count, and the ranges for time and location.

Results can be filtered by answer location and by subject demographic, such as nationality and age. This provides the ability to view statistics for what was the first answer for Americans aged 20 – 22 years old.
Figure 32: Summary Report

Connectivity Report: The Connectivity Report shows the relationship between answers for a question. Each unique answer for the question is listed in a descending order with the most frequent answer listed first and the least answered listed last. A target answer is an answer for which we are analyzing, and the connected answers are all the other answers for the question for the subjects who had the target answer. Each target answer has a table which lists every connected answer. Using the example in Figure 33, the first target answer is “Aunt”, and the table lists every answer provided by the subjects that responded “Aunt”.

The table has four columns: Answer, Match Count, Average Distance and Significance. The border shows the target answer and the number of subjects that provided the answer. Match count is the number of times that a subject answered the target answer and the answer in the first column of the table. In this example, of the 78 subjects that answered “Aunt”, 74 also answered “Uncle”. Average distance is the difference in answer location on average. For example, a subject could have these answers:

- Mother
- Father
- Aunt
- Uncle

Distance is calculated by the number of lines between answers. The distance between “Aunt” and both “Father” and “Uncle” is 1, and the distance between “Aunt” and “Mother” is two. The average distance of 1.08 indicates that most of the time “aunt” and “uncle” were answered next to each other.
Significance is a combination of Match Count and Average Distance. (Average Distance / (Match Count / Target Answer Count)). This provides a better indicator of connectivity because it eliminates the extreme outliers of the other two indicators. If “maternal grandmother” was answered right after “aunt”, but they were only answered together once, their Average Distance would be a perfect 1, but wouldn’t be a strong indicator. Likewise in this example, grandfather was an average distance of 3.77 from “aunt”, but is listed below “sister” whose distance is 5.08 because “sister” was answered one more time than “grandfather” (sister matched 68%, grandfather matched 67%).

Edit: The edit panel has four options: Aggregates, Tentatives, Answer Groups and Save Matrix.

Question Answer Aggregates: The aggregate function allows the user to combine subject answers into an umbrella answer called the aggregate answer. The basic idea is that when generating reports about the answer “brother,” the report should include case sensitive answer “Brother,” the plural version “brothers,” the misspelled versions such as “Borther” and interrupted answers such as “brothe.”

There are other reasons to aggregate. For other categories, such as Metals, aggregate answers can include the element name “silver” and the chemical symbol “Ag.” In the category Things in a Park, aggregate answer “air” could include “fresh air,” “clean air,” “oxygen,” and “air to breathe.”

The top section of the screen displays the created aggregates and the bottom section lists the answers that are still singletons and not combined with other answers (see Figure 34). The table above lists the aggregate answer, the answers it covers, and the tentative answers that may be covered in the future. The tentative feature is for situations in which the analyst is unsure if the answer is part of the aggregate, but wants to mark it for further consideration. It is not included with the aggregate answer in the generated reports.

The application can generate aggregates automatically. Capitalization and plurality are mostly caught, but misspellings or familiar forms of words, such as “auntie” for “aunt” are not caught.
Aggregates: The data set comes from the surveys that were taken by a number of subjects from different cultures and countries. As a result of the answers being freely entered by the subjects of differing backgrounds, data that convey the same information will be written in multiple ways. For instance in the Relatives category, you may get these four answers:

- Grandpa
- Grandfather
- Grampa
- Grandfarther

The first two answers are the common English names for the father of one of your parents. The last two are misspelled versions of the first two. If you didn’t aggregate these results together, the summary reports would be faulty. They may tell you that 95% of subjects said cousin, but only 73% said grandfather. However, if you combined the results of all four versions, it might indicate that 92% of the subjects said grandfather. This is why aggregation is valuable.

Aggregation does not modify the original result sets, so they remain untouched. Aggregated data can be changed back at any time.
Aggregate Report: The Aggregate Report will list every answer aggregate created for this data set group by their question. The report is a text based report, and is generated as a temporary file and displayed in Notepad (see Figure 35).

The report is structured like this:

Question Text
Aggregate Name: answers covered [tentative answers]
Figure 35: Aggregate Report

**Tentatives**: The Tentatives edit tool enables the analyst to go back to tentative answers and add them to the aggregate answer they were assigned to (see Figure 36).

Figure 36: Tentatives
Answer Table: The answer table is shown at the bottom of the screen (see Figure 37). The table lists every answer for the question, with the fields Question #, Subject ID, Result, Entry Time, Exit Time, Total Time, and Entry Number. The table can be sorted by any column. The data in Question # and Subject ID link to the Question and Subject pages respectively.

![Figure 37: Answer Table](image)

Answer Groups: Answer Groups is an unfinished edit tool for possible future development. The object of this feature is similar to aggregation, only at the next level. For example, in the category games, there could be the answers “Madden,” “Super Mario Bros.,” “football,” “soccer,” “Monopoly,” and “checkers.” These six answers could be put into three answer groups, “video games,” “ball games,” and “board games.” Other answer groups could include “card games,” “imagination games,” and “playground games.” There are no reports currently developed that include this type of data.

Save Matrix: The save matrix button will save the question information to a matrix file for use in PDAT.

Answers: All of the answers in the survey are loaded into the application. The Answer Table has every answer in the survey. The fields in the table are Question Number, Subject ID, Result, Entry Time, Exit Time, Total Time, and Entry Number (see Figure 38). The values in the Question Number link to the question page and the values in the Subject ID field link to the subject information page.
Subjects: All of the subjects’ information in the survey is loaded into the application. The Subject Table lists every subject in the survey. The Subject Summary report can be generated by selecting the Generate Report button in the upper right corner of the screen (see Figure 39).
Figure 39: Subjects

**Subject Table:** The fields in the Subject Table are ID, Nationality, Start Date, End Date, Age, and Gender. The values in the ID column link to the subject information page.

**Subject Summary:** The Subject Summary report gives summary information about the survey results broken down by subject groups (see Figure 40). The report is currently broken down by nationality, but could be modified in the future to be broken down by gender/age/etc.

The first panel is the “All” panel, which shows the results for all subjects. The rest of the panels are broken down by subject nationality. Each panel has two sections: Summary and Question Type. The Summary section lists subject count, unique words, total words, and unique per subject. The Question Type selection lists all the question types as set in the Data Annotation dialog. Each type lists the number of questions in that type, the average number of answers for each question of that type, and the average amount of time for each of those answers.
Figure 40: Subject Summary

Panel Report: The Panel Report breaks down the subjects by their demographic information. Subjects are grouped overall and by their nationality (see Figure 41). Each demographic question lists the multiple choice options and number of responses (fixed), or they list the provided answers (aggregated in the Aggregate tool) and number of responses (dynamic). The dynamic results are Languages Spoken/Written, Nationality, and Language Preference.
Figure 41: Panel Report

Subject Aggregates: The Subject Aggregates tool creates aggregate answers for subject demographic data (see Figure 42).

Figure 42: Subject Aggregates
The combo box at the top of the panel lists the demographic information groups that can be aggregated (see Figure 43).

![Figure 43: Demographic Information Groups](image)

The Subject Aggregates tool works the same way that the Question Answer Aggregate tool does. **Annotation:** Some data is automatically parsed, but sometimes the parsing fails. Data annotation is used to clear those data pieces up, and to set up categories for questions used in the survey. There are four data elements that can be annotated: Question Type, Nationalities, Time in US and Languages (see Figure 44).

![Figure 44: Data Annotation](image)

**Question Type:** Question type data is not found anywhere in the data. Question types are crafted by the survey generator and can be entered using the Type tab of the Data Annotation screen. The Set Types button enables the user to input the question types, and the Modify Questions button is used to assign the types to the questions in the survey (see Figure 45).
Nationalities: Nationality is an important piece of information for grouping subjects in Survey Analysis. Some subjects neglected to enter a value for nationality, perhaps because they were confused by the question or just missed it. The Nationalities tab allows the user to view the subject’s demographic information and determine nationality if possible. Once the user updates this information, the data to the right of the field is marked with a red asterisk to indicate that this piece of information was modified by the user (see Figure 46).
Figure 46: Nationalities

Time in US: The third tab on the Data Annotation screen is the “Time in US” tab. Survey Analysis parses this data set as best as it can, and converts the information into months. Some values entered cannot be parsed, and have to be entered manually on this screen. The combo box lists all the subjects with problem data. The User Value is the value the subject entered for the Time in the US question. The Annotate Value is what is currently set for that subject’s time in the US. The default is -1 month. In this example, the subject has been in the US for 15 days see (Figure 47). The user can decide to round down to zero months or up to one month.
**Languages**: The fourth tab on the Data Annotation screen is the “Languages” tab (see Figure 48). This tab contains the tools to annotate the information provided by the subjects, concerning the languages they speak. The available languages are listed at the top of the panel. Each response is listed in the first column of the data, and the appropriate languages are checked in each row. This is automatically parsed from the data provided. If any of the answers appear to be misspelled, the appropriate check boxes can be marked here.
### Figure 48: Languages

**Survey Summary**: The Survey Summary gives a summary of the answers given for each question (see Figure 49). Questions are grouped together by their type. Filtering options for nationality and aggregates are available.
Options: There are two groups of options under the Survey Summary Selection: Type and Settings (see Figure 50). The left panel is labeled Type. The “Summary” option generates the report with all nationalities included. Listed below “Summary” are all of the available nationalities. Selecting one of these choices generates the report using only results from subjects of that nationality.

Settings are displayed on the right of the panel. There are three settings that can be chosen:

- **Exclude** – If checked, the report will only show the answers that were answered by a certain percentage of the selected subjects. Default selection is 5%.
- **Aggregates** - If selected, the report will break down each aggregate value. For example:
  - Apple was answered by 80% of subjects
  - Apple is an aggregate answer, and covers four answers
    - Apple – 70%
    - Red Apple – 5%
    - Green Apple – 4%
    - Yummy Apple – 2%
- **CSV** – Instead of displaying the report, if this setting is checked a CSV file is generated and saved to the file system. The CSV file can then be loaded into a program such as Excel.

![Survey Summary Selection](image)

**Figure 50: Survey Summary Selection**

4.8 Report

The report groups questions by their question type (see Figure 51). Under the text of the question are the answers for that question. Each answer is one row of the table.

- **Response** – The answer provided by the subjects.
b. **Total (#)** – The # is the number of subjects who answered this question. The value in the column is the percentage of subjects who answered this question with this response.

c. **First** – The percentage of subjects who answered this question who chose this response first.

d. **RT Overall** – The average response time.

e. **RT First** – The average response time for this response if it was chosen first.

f. **Rank** – The average location of the response.

g. **Nationality (##)** – In the overall summary, the last columns will display all the nationalities and the percentage of subjects of this nationality who responded with this answer. The ## is the number of subjects of this nationality.

<table>
<thead>
<tr>
<th>Response</th>
<th>American</th>
<th>First</th>
<th>RT Overall</th>
<th>RT First</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>cousin</td>
<td>0.10</td>
<td>0.10</td>
<td>2.8</td>
<td>5.6</td>
<td>5.9</td>
</tr>
<tr>
<td>--- cousin</td>
<td>(0.77)</td>
<td>(0.07)</td>
<td>(2.2)</td>
<td>(3.9)</td>
<td>(6.3)</td>
</tr>
<tr>
<td>--- cousins</td>
<td>(0.17)</td>
<td>(0.03)</td>
<td>(6.0)</td>
<td>(8.9)</td>
<td>(3.8)</td>
</tr>
<tr>
<td>--- Cousin</td>
<td>(0.07)</td>
<td></td>
<td>(2.0)</td>
<td></td>
<td>(7.0)</td>
</tr>
<tr>
<td>aunt</td>
<td>1.00</td>
<td>0.37</td>
<td>2.5</td>
<td>3.4</td>
<td>4.3</td>
</tr>
<tr>
<td>--- Aunt</td>
<td>(0.10)</td>
<td>(0.07)</td>
<td>(3.2)</td>
<td>(4.0)</td>
<td>(2.7)</td>
</tr>
<tr>
<td>--- aunts</td>
<td>(0.17)</td>
<td>(0.10)</td>
<td>(3.0)</td>
<td>(3.4)</td>
<td>(1.8)</td>
</tr>
<tr>
<td>--- aunt</td>
<td>(0.73)</td>
<td>(0.20)</td>
<td>(2.3)</td>
<td>(3.3)</td>
<td>(5.1)</td>
</tr>
<tr>
<td>uncle</td>
<td>0.97</td>
<td>1.6</td>
<td>4.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- uncle</td>
<td>(0.07)</td>
<td>(1.6)</td>
<td>(4.5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- uncles</td>
<td>(0.17)</td>
<td>(1.7)</td>
<td>(2.4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- uncle</td>
<td>(0.73)</td>
<td>(1.6)</td>
<td>(5.3)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>grandfather</td>
<td>0.87</td>
<td>3.3</td>
<td>8.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- Grandpa</td>
<td>(0.07)</td>
<td>(3.4)</td>
<td>(10.0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- grandpa</td>
<td>(0.47)</td>
<td></td>
<td>(7.7)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- grandpas</td>
<td>(0.03)</td>
<td></td>
<td>(1.8)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- grandfather</td>
<td>(0.27)</td>
<td>(4.0)</td>
<td>(9.0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- grandpa</td>
<td>(0.03)</td>
<td></td>
<td>(2.8)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sister</td>
<td>0.87</td>
<td>2.0</td>
<td>6.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- sister</td>
<td>(0.77)</td>
<td>(2.0)</td>
<td>(6.6)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- sisters</td>
<td>(0.03)</td>
<td>(2.1)</td>
<td>(5.0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- Sister</td>
<td>(0.07)</td>
<td>(1.8)</td>
<td>(4.0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>grandmother</td>
<td>0.87</td>
<td>0.07</td>
<td>3.2</td>
<td>3.9</td>
<td>7.2</td>
</tr>
<tr>
<td>--- grandmas</td>
<td>(0.03)</td>
<td>(1.3)</td>
<td>(3.0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- Grandma</td>
<td>(0.03)</td>
<td></td>
<td>(4.8)</td>
<td>(8.0)</td>
<td></td>
</tr>
<tr>
<td>--- Grandma</td>
<td>(0.03)</td>
<td></td>
<td>(3.8)</td>
<td>(10.0)</td>
<td></td>
</tr>
<tr>
<td>--- grandma</td>
<td>(0.50)</td>
<td>(0.07)</td>
<td>(3.5)</td>
<td>(3.9)</td>
<td>(6.6)</td>
</tr>
<tr>
<td>--- grandmother</td>
<td>(0.27)</td>
<td>(2.6)</td>
<td>(8.3)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mother</td>
<td>0.83</td>
<td>0.20</td>
<td>2.1</td>
<td>4.3</td>
<td>3.8</td>
</tr>
</tbody>
</table>

**Figure 51: Summary Survey (American)**

4.8.1. **Finished Survey Results**

Data from the first set of surveys has been gathered through the Qualtrics survey. Subjects took the survey in English, regardless of their first or preferred language. The Qualtrics data collection is complete and the results were downloaded on 14 March 2013.
4.9 Panel Information

There were 94 subjects who participated in this survey.

- Gender – 53% male / 47% female
- Age – 73% were aged 18-25, 17% were 26-35, 3% were 36-50, and 6% declined to answer.
- Languages Spoken/Written – 95% listed English, 33% Hindi, 28% Chinese, 23% Telugu, 18% Spanish, 9% Tamil, and no more than 4% for any other language.
- Nationality – 34% Indian, 32% Chinese, 32% American, and 1% for both Mexican and Serbian.
- Language Preference – 36% preferred English, 24% Chinese, 22% Telugu, 5% Hindi and 1% for a number of other languages.

4.10 Translation

The surveys will be conducted in a number of different languages, so a translation tool will be needed.

4.10.1 Criteria for translation tool

A variety of criteria were used to select the software for data collection. The criteria included:

a. Languages supported
b. Human translated vs. machine translated
c. Amount of time required for translation
d. Cost

The data collection software was evaluated against these criteria. The four language translations that the software must provide are Chinese, Urdu, Sanskrit and Hindi. Human translations are better for sentences, but machine translation may be adequate for some of the one word responses.

To receive an adequate quote on cost and time, the number of words requested was 1000 for each of the required languages.

4.10.2 Translation Options

There were six evaluated services that provide human translation of the four languages, and three machine translation tools that provide translations for three of the languages (sans Sanskrit). A breakdown is shown in Figure 52.

4.10.3 Human Translation Options

The human translation options are Advanced Language, AltaLang, Betmar, Lionbridge, Transperfect, and Verbatim Solutions.

4.10.4 Machine Translation Options

The machine translation options are Ace Translator, Babylon and Google.
### Translation Services

<table>
<thead>
<tr>
<th>ID</th>
<th>Service Name</th>
<th>Website</th>
<th>Cost</th>
<th>Notes</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $810.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Transperfect</td>
<td><a href="http://www.transperfect.com/">http://www.transperfect.com/</a></td>
<td>$190, $290, $290</td>
<td>5 day complete</td>
<td>✔️</td>
</tr>
<tr>
<td>12</td>
<td>Advanced Language</td>
<td><a href="http://advancedlanguage.com">http://advancedlanguage.com</a></td>
<td>$1075</td>
<td>3-5 day complete</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $1,075.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>AltaLang</td>
<td><a href="http://www.altalang.com">http://www.altalang.com</a></td>
<td>$200(s), $240(t), $280, $480, $260</td>
<td>3 day complete</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $1,240.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Betmar</td>
<td><a href="http://www.betmar.com">http://www.betmar.com</a></td>
<td>$595, $625, $625, $625</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $2,470.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Ace Translator</td>
<td><a href="http://www.acetools.biz/">http://www.acetools.biz/</a></td>
<td>$59.95</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $59.95</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total: $118.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.0 CONCLUSIONS

The use of OMAR to run scenarios in Neverwinter Nights and input the results to PDAT was successful. The resulting displays in PDAT are very informative, and will provide easier analysis of the data, as the scenarios become more complex and lengthy. The variety of reports provides a deeper analysis that will be valuable in revealing trends in the data.

The Neverwinter Nights’ displays have issues that need to be addressed, in order to streamline scenario display. The environments can be manipulated, but when running the scenarios, in order to view the events in the scenario, an active response is required. There have been discussions regarding changing the tool used for scenario display, with OpenSim being a top candidate to replace Neverwinter Nights. OpenSim will be evaluated in the future to determine if it has the functionality to replace the current simulation tool.

Data collection will start in the near future. No problems are anticipated with the retrieval of the data. The tool has been tested, and all issues were resolved with simple fixes. Qualtrics has all the necessary tools for collection according to our specific needs, including timing and automatic page change features. The results returned from Qualtrics will be analyzed and detailed in a future report.

5.1 Aggregation

Aggregation is a necessity for evaluation of the data provided by the subjects. Due to the nature of the surveys, answers for all the category questions and some of the demographic questions are text based. This means that subjects are not forced to follow any particular standard of entering data. Questions with radio button selections have a finite number of answers that can be provided, while text based answers are nearly infinite.

In general, answers need to be the same across users. There are a finite number of different types of fruit for example, but that finite group grows with every misspelled word, misplaced punctuation, and other anomalies.

For questions that are more abstract, such as “Please list some examples of a way to advertise something,” similar answers vary much more (see Figure 53).

<table>
<thead>
<tr>
<th>Question</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>newspaper</td>
<td>0.44</td>
</tr>
<tr>
<td>--&gt; new papers</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; news papper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; news papper adds</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; in the paper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; local news paper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; news papers</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; classified in newspaper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; newspaper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; newspaper ad</td>
<td>(0.02)</td>
</tr>
<tr>
<td>--&gt; by newspaper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; News Paper</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; newspapers</td>
<td>(0.03)</td>
</tr>
<tr>
<td>--&gt; newspaper advertisement</td>
<td>(0.01)</td>
</tr>
<tr>
<td>--&gt; newspaper</td>
<td>(0.27)</td>
</tr>
</tbody>
</table>

Figure 53: Newspaper Answer
In the above example, 44% of the subjects answered a form of newspaper as an example of a way to advertise something. The most common answer was “newspaper”, which was the answer in 27% of survey results.

There are 14 answers that have been combined for this aggregate answer. Besides “newspaper,” the other 13 answers had one or more reasons why they needed to be aggregated.

- 7 added a space between “news” and “paper”
- 1 used capitalization (News Paper)
- 2 misspelled paper (“papper”)
- 1 misspelled news (“new”)
- 2 pluralized paper to papers
- 4 referenced a specific element of a newspaper (“ad” or “Classified”)
- 1 defined what kind of newspaper (“local”)
- 2 added unnecessary words (“by newspaper” and “in the newspaper”)

Without aggregation, 16 answers would have been lost by default, as none of the aggregated answers other than “newspaper” would have reached the default 5% threshold. “Newspaper” would have appeared to be answered only by a quarter of subjects, as opposed to nearly half.

While the benefits of aggregation are made clear by this example, there are downsides and risks to this approach. First, aggregation is a slow, tedious and time consuming process. Each question has its own group of aggregates, so the process must be run for all 58 questions in the survey. Automation handles some capitalization and plurals, but many of the aggregate answers are not covered by automation.

Aggregates were not automatically generated, rather the analyst could run automation, if they so desired. The reasoning was a fear that some answers may actually be different if capitalized. In the statements “A Christian loves God” and “Zeus is a god,” the word “god” is different if capitalized. There may be other examples in other languages as well.

If this application is expanded, it would be recommended that automation be run every time, as the number of mistakes are few and can easily be fixed. Unfortunately, it is still recommended to provide aggregates within each question, to avoid cross contamination between questions. For example, if the category was “things in an office,” “apple,” “computer,” and “laptop” may be grouped together under computer. However, “computer” would be listed in the “fruit” category, instead of “apple.”

The more complicated issue is determining which answers should be aggregated. Is “Classified in newspaper” a part of “newspaper” or “classified”? It contributes to the fidelity of the answers. “Newspaper” could cover advertisements printed in the paper, classified ads, an article written about a product, a paper insert, or a free sample provided with the Sunday paper. Then the question of how to handle advertisements on a newspaper’s webpage only complicates the situation.

Due to the nature of the survey, the subject provided answers within a time limit (60 or 90 seconds). As such, participants may not spend much time differentiating the specific elements of a newspaper. The aggregates that were created for this analysis showed preference to grouping at
a higher level. Using the example above, the answers were grouped under “newspaper” instead of breaking them up into smaller groups like “newspaper,” “newspaper ad,” and “newspaper classified.”

5.2 Question Categories

Each question in the survey was assigned a question type. Results from the survey can be broken down to show how these question types compare to one another.

The eight question types are as follows:

- **Ad Hoc**: Non-generalized questions that provides answers specific to the question (e.g., items that are green)
- **Characteristics**: Characteristics of a specific object (e.g., characteristics of a good life)
- **Goal Driven**: Question that list items to achieve a goal (e.g., how to advertise)
- **Relational**: Relational questions ask the subject to list items that are related to a category that is a bit more vague than Taxonomic (e.g., a tool)
- **Taxonomic A**: List items of a specific category (more universal, e.g., color)
- **Taxonomic B**: List items of a specific category (less universal, e.g., mythical being)
- **Thematic**: Questions that ask about items associated with a situation (e.g., a party)

Sorting these question types by the average number of answers a subject provides for each question shows that 5 of the 8 categories have averages between 7.00-7.99 answers. The outliers are the Taxonomic-A category at 9.34 answers on the high end, and Characteristics at 6.24 and Relational at 5.34 on the low end.

In general, American answers had the highest averages, ranging from 6.57 to 11.63. Indian answers were next, ranging from 4.95-8.72, while Chinese answers averaged from 4.41 to 7.53.

The three outlier types were consistent across the nationalities, as Taxonomic-A was the highest average for all three nationalities, and Characteristics and Relational were 7th and 8th as well.

Within the breakdown for each nationality, the overall results for both American and Indian participants were very close to the same order. This was not unexpected, as together they comprised around 2/3rds of the overall survey population. Results obtained from Chinese participants were mildly interesting, as Goal Driven was their 2nd highest average (6th for All) and Taxonomic-B was 6th (2nd for All). This is only mildly interesting as the difference between 6th (5.66 answer average) and 2nd (5.85) is negligible.

Looking at the speed in which the answers were provided, the results mirror the average answer count results. Overall Taxonomic-A was the fastest at 4.89 seconds per answer and Relational was the slowest at 8.29 seconds. Reaction times for Americans were the fastest, ranging from 3.96 to 7.03 seconds, Indian reaction times ranged from 5.28 to 8.4 seconds, and the reaction times of Chinese subjects averaged 5.93 to 10.33 seconds.

The only differences in ranking the question types occurred between Thematic and Ad Hoc. Thematic question types had the third most answers, but were 5th in answer speed, while Ad Hoc
question types were the reverse, having the fifth most answers but the third fastest answer speeds.
### 6.0 SYMBOLS, ACRONYMS AND ABBREVIATIONS

<table>
<thead>
<tr>
<th>ACRONYM</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D</td>
<td>Two Dimensional</td>
</tr>
<tr>
<td>3D</td>
<td>Three Dimensional</td>
</tr>
<tr>
<td>711HPW/RHC</td>
<td>711th Human Performance Wing Warfighter Interface Division</td>
</tr>
<tr>
<td>711HPW/RHXM</td>
<td>711th Human Performance Wing Human Analyst Augmentation Branch</td>
</tr>
<tr>
<td>AFRL</td>
<td>Air Force Research Laboratory</td>
</tr>
<tr>
<td>CDRL</td>
<td>Contract Data Requirements List</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma Separated Values</td>
</tr>
<tr>
<td>ISR</td>
<td>Intelligence, Surveillance, and Reconnaissance</td>
</tr>
<tr>
<td>JUNG</td>
<td>Java Universal Network/Graph Framework</td>
</tr>
<tr>
<td>NWN</td>
<td>Neverwinter Nights</td>
</tr>
<tr>
<td>OMAR</td>
<td>Operator Model Architecture</td>
</tr>
<tr>
<td>PDAT</td>
<td>Polyhedral Dynamics Analysis Tool</td>
</tr>
<tr>
<td>TO</td>
<td>Task Order</td>
</tr>
<tr>
<td>WIRTO</td>
<td>Warfighter Interface Research and Technology Operations</td>
</tr>
</tbody>
</table>
7.0 GLOSSARY

Concept
An object made up of nodes and edges can be identified with a unique ID. Typically a concept will have a name (i.e., Beagle), and will be visible on the graph in its own color.

Edge
An object that connects two nodes. In a concept, all nodes (attributes) of the concept will connect to each other through an edge. An edge can have a weight assigned to it, signifying the strength of the bond between the nodes that it connects.

Layout
A mechanism for returning (x, y) coordinates for nodes.

Matrix
An X by X grid of data that establishes the connection of a concept and its nodes. The matrix can also define concepts and nodes.

Node
An attribute that makes up a portion of a concept. It has an ID, and typically will have a name (i.e., Brown). It is displayed on the graph as a filled circle.

  a. Cut. A node that when removed, produces a graph with more connected components than the original graph.
  b. Leaf. A node that has one edge.
  c. Initial. A node which a directed edge starts at.
  d. Isolated. An unattached node which has no edges.
  e. Normal. A node that has both incoming and outgoing edges.
  f. Sink. A node which has no out edges. All edges connected to this node end at this node.
  g. Source. A node which has no in edges. All edges connected to this node start at this node.
  h. Terminal. A node which a directed edge ends at.